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 روش های بازکردن فایل اکسل  -1

 اکسل مانند ورد دو روش وجود دارد:  برای باز کردن فایل

 ه مورد نظر مراحل زیر را طی کنید:و یا پوش Desktopصفحه  در  -1

Right Click → New → Microsoft Excel Document 

 این فایل در همان مکانی که ایجاد شده ذخیره می شود.

را جستجو کنید. برای    Excelرا از صفحه کلید بفشارید و عبارت    روی منو استارت کلیک کرده و یا کلید    -2

 ذخیره کردن این فایل باید مکان ذخیره سازی فایل را مشخص کنید.

 مقدمات اکسل  -2

2-1  Right to Left  کردن صفحات 

 Right( هستند. برای راست به چپ )Left to Rightصفحات اکسل معمولا به صورت پیش فرض از چپ به راست )

to Left  کردن این صفحات از تب )Page Layout  قسمت ،Sheet Options  گزینه ،Sheet Right to Left   را انتخاب

 کنید. 

 ها  تغییر آدرس سلول 2-2

ا ا بستون ها با حروف و سطره  به صورت پیش فرض   که در آن  در اکسل هر سلول دارای آدرس مخصوص به خود است

این آدرس در گوشه   می شود. آورده( در این حالت اول حرف ستون و سپس شماره سطر  A1 اعداد نشان داده می شوند. )مثلا

سلول های اکسل هم سطر و هم ستون با عدد  در صورتی که بخواهید در آدرس  بالا و چپ صفحه اکسل قابل مشاهده است.  

 ( مراحل زیر را انجام دهید: R1C1نشان داده شود )مثلا 

File → Options → Formulas → working with formulas → 

R1C1 reference style 

 در این حالت اول شماره سطر و سپس شماره ستون آورده می شود.

 سلول ها  انتخاب 2-3

 در گوشه صفحه کلیک کنید. استفاده کنید یا روی آیکون   Ctrl + Aهمه سلول ها یا از کلید میانبر  انتخاببرای 

 پس از انتخاب همه سلول ها می توانید به راحتی تنظیماتی مثل تغییر فونت و ... را انجام دهید.
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استفاده کنید به این صورت که یک سلول    Ctrlبرای انتخاب سلول هایی که در مجاورت هم نیستند می توانید از کلید  

 را نگه دارید و سلول های دیگر مد نظر خود را انتخاب کنید. Ctrlیا محدوده ای از سلول ها را انتخاب کرده سپس کلید 

 اضافه کردن سطر یا ستون  2-4

یگر اضافه کنید، بر روی  اگر در هنگام کارکردن با اکسل خواستید قبل از سلولی که در آن متنی نوشته اید یک سلول د

را انتخاب کنید. یک سطر یا   Insertقسمت نام سطر یا ستونی که سلول مورد نظر درآن قراردارد، راست کلیک کرده و گزینه  

 ستون قبل از آن اضافه می شود. 

 

 زوم کردن در اکسل  2-5

 برای زوم کردن در اکسل مانند ورد دو روش وجود دارد:

 ارید و با استفاده از کلید اسکرول موس )کلید وسط موس( میزان زوم را تنظیم کنید.را نگه د  Ctrlکلید  -1

در قسمت پایین و سمت راست صفحه اکسل بخشی برای تغییر میزان زوم صفحه وجود دارد که می توانید برای تنظیم    -2

 زوم کردن از آن استفاده کنید.

 نوشتن اعداد به صورت اتوماتیک  2-6

اکسل می تواند در صورت تشخیص رابطه بین دو عدد به صورت اتومات آن رابطه را ادامه داده و اعداد بعدی را بنویسد. 

از این توانایی می توان برای نوشتن ردیف، جدول ضرب و ... استفاده کرد. برای این کار در ستون یا سطر مورد نظر)یا هردو( 

به هم دارای رابطه مورد نظر شما هستند را بنویسید سپس آنها را با هم انتخاب کنید و در چند سلول پیاپی، چند عدد که نسبت  

 (.Drag & Dropکنید)بکشید و رها در می آید، در جهت صحیح  در جایی که آیکن ماوس به شکل 
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Drag & Drop یز می توان از آن  فقط برای اعداد کاربرد ندارد بلکه برای انتقال تنظیمات دیگر به سلول های مجاور ن

استفاده کرد. مثلا اگر جدولی دارید که تنظیمات مختلفی روی آن اعمال کرده اید و می خواهید یک سطر یا ستون دیگر به آن  

 کنید. Drag & Dropاضافه کنید، کافیست دو سطر یا ستون آخر آنرا انتخاب کرده و تا جایی که می خواهید  

2-7 Hide  )سطر و ستون کردن )پنهان کردن 

اگر بخواهید سطر یا ستونی در فایل اکسل وجود داشته باشد ولی نشان داده نشود، کافیست بر روی شماره سطر یا نام  

 را انتخاب کنید.  Hideستون راست کلیک کرده و گزینه 

 
یا ستون قبلی و    کردید، دوباره نشان داده شود ابتدا باید سطر  Hideدر صورتی که بخواهید سطر یا ستونی که آن را  

 کلیک کنید. Unhideبعدی آن را با هم انتخاب کنید، راست کلیک کرده و روی گزینه  
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 کلیدهای میان بر در اکسل  -3

 + Ctrl رفتن به آخرین سطر 

 + Ctrl رفتن به آخرین ستون 

 Ctrl + A      انتخاب همه سلول ها 

   + Ctrl + Shift  داده داردانتخاب سلول های یک ستون تا آخرین سلولی که 

    + Ctrl + Shift انتخاب سلول های یک سطر تا آخرین سلولی که داده دارد 

 ها  Sheetتنظیمات  -4

  Sheetاضافه کردن  4-1

جدید با تنظیمات پیش فرض   Sheetدر پایین صفحه کلیک کنید. یک    بر روی علامت  Sheetبرای اضافه کردن 

 به فایل اکسل شما اضافه می شود.

 

 Sheetکپی کردن  4-2

همان تنظیمات    ی که اضافه می کنیدجدید   Sheetقبلی تنظیمات خاصی اعمال کردید که می خواهید در    Sheetدر    اگر

و در پنجره باز شده،    را انتخاب کنید  Move or Copyگزینه    قبلی راست کلیک کرده و  Sheetرا داشته باشید، باید روی  

 قبلی می گیرد.  Sheetاعمال زیر را انجام دهید. در این حالت اکسل یک کپی از  
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 Sheetجا به جا کردن  4-3

 برای این کار دو راه وجود دارد: 

انتخاب   مورد نظر را  Sheetجا به جا کرد. به این معنی که    Drag & Dropهای موجود را با    Sheetمی توان    -1

 کرده و آنرا به جایی که می خواهید، بکشید و سپس رها کنید.

را انتخاب کنید. در پنجره باز شده مشخص    Move or Copyمورد نظر راست کلیک کرده و گزینه    Sheetبر روی    -2

  Sheet4مورد نظر قبل از    Sheetرا انتخاب کنید،    Sheet4. مثلاً اگر در این قسمت  را به کجا ببرید  Sheetکنید می خواهید  

 کنید. را انتخاب   OKسپس  قرار می گیرد.

 

1 

2 
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 Sheetتغییر نام  4-4

 ها دو راه وجود دارد:   Sheetتغییر نام  برای

 و نام آن را تغییر دهید. کنیدمورد نظر دوبار کلیک  Sheet  روی -1

 . کلیک کنید و نام آن را تغییر دهید Renameمورد نظر راست کلیک کرده و بر روی گزینه  Sheet  روی -2

 Sheetحذف  4-5

 را انتخاب کنید.   Delete، روی آن راست کلیک کرده و گزینه Sheetبرای حذف کردن یک 

 Sheetرنگی کردن قسمت نام  4-6

ظر راست کلیک کنید و نشانگر موس را روی گزینه مورد ن  Sheetها، باید روی    Sheetرنگی کردن قسمت نام    برای

Tab Color .تخاب کنید.در پنجره ای که باز می شود رنگ دلخواه تان را ان نگه دارید 

 

 

 به فایل اکسل دیگر  Sheetکپی یا انتقال  4-7

 Moveراست کلیک کرده و گزینه    Sheetرا در فایل اکسل دیگری کپی کنید باید روی آن    Sheetر بخواهید یک  اگ

or Copy  در قسمت   در پنجره باز شده،کنید.  انتخاب    را  To book    را باز کرده و روی گزینه  لیست آبشاریnew book  

 نیز فعال کنید.را  Create a copyتیک گزینه  کنید.کلیک 
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تیک گزینه برای انتقال،  به فایل اکسل دیگر نیز تمام مراحل فوق باید انجام شود با این تفاوت که    Sheet  یک  برای انتقال

Create a copy  .نباید فعال شود 

 تنظیمات سلول ها  -5

 تغییر اندازه سلول  5-1

 روش وجود دارد:  تغییر اندازه سلول در اکسل چهار  برای

نوشته شده است،  اندازه سلول را به صورت دستی تغییر دهید. به این صورت که در قسمتی که نام ستون هامی توانید  -1

 بر روی مرز سلول کلیک کنید و نگه دارید. سلول را تا جایی که می خواهید بکشید و سپس رها کنید. 

 
 ها نوشته شده است انجام دهید. برای تغییر اندازه سلول به صورت عمودی همین کار را در قسمتی که نام سطر  

 

1 

2 

3 

4 
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می خواهید در اندازه آن تغییر ایجاد کنید   ،سلولخود  در صورتی که به دلیل بزرگ تر بودن نوشته داخل سلول از    -2

سلول    روینوشته را به اندازه ای کنید که در سلول مورد نظر جای بگیرد. برای این کار    به جای تغییر اندازه سلول،  می توانید

 کنید. را انتخاب   Format Cellsمورد نظر راست کلیک کرده و گزینه 

 

 کلیک کنید. Alignment Settingبر روی لیست آبشاری   Alignment، قسمت  Homeو یا در تب  

 
 صفحه زیر باز می شود که باید در آن تنظیمات زیر را انجام داد.  صورت هردودر 
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ل های اکسل نوشتید و متن بزرگ تر از سلول مورد نظر بود، برای تغییر اندازه سلول به  اگر متنی را داخل یکی از سلو  -3

 صورت عمودی )به طوری که قسمتی از متن در پایین قرار گیرد( می توانید به صورت زیر عمل کنید.

 
تنی می  قا به اندازه مدر قسمت نام سطرها یا ستون ها، بر روی مرز سلول دوبار کلیک کنید. در این صورت سلول دقی  -4

توجه داشته باشید که در صورت تغییر اندازه یک سلول به صورت افقی یا عمودی، اندازه تمام  شود که داخل آن نوشته اید.  

 سلول های ستون یا سطری که سلول در آن قرار دارد، تغییر می کند.
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 تغییر جهت سلول  5-2

 ییر دهید:را از حالت افقی به عمودی یا مورب تغ آنمتن داخل   سلول و  خواهید جهتاگر می 

Right Click → Format Cells → Alignment → Orientation 

Home → Alignment Setting 

 درجه تغییر در جهت سلول اعمال کنید. 180می توانید تا  Orientationدر قسمت 

 

 ادغام کردن سلول ها 5-3

  Homeبه تب  و یکی کردن آنها، سلول های مد نظر خود را انتخاب کرده  یکدیگر  برای ادغام کردن دو یا چند سلول با  

 کنید.را انتخاب   Merge & Center، گزینه Alignmentاز قسمت  بروید و  
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 خطوط بین سلول ها 5-4

فایل ط از یک  در اکسل خطوطی که سلول ها را از یکدیگر جدا می کنند فرضی هستند و اگر شما بدون تعریف خطو

اکسل، نسخه چاپی تهیه کنید هیچ مرزی بین سلول ها وجود نخواهد داشت. برای تعریف این مرز ها، محدوده ای که می خواهید  

 وس انتخاب کنید و مسیر زیر را دنیال کنید.ا خطوط بین سلول ها در آن نشان داده شود را با استفاده از م

 
ول هایی که می  خطوط فرضی بین سلول ها را محو کنید، سلشوند و  فقط خطوط تعریف شده نشان داده  اگر بخواهید  

  Fill Colorی گزینه  رو  Fontبروید و در قسمت    Homeخواهید خطوط فرضی شان را محو کنید انتخاب کرده، به تب  

 )آیکون سطل رنگ( کلیک کرده و رنگ سفید را انتخاب کنید. 
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 اعداد تعیین تعداد رقم های اعشار برای  5-5

ول هایی که اگر بخواهید تعیین کنید که اعداد اعشاری تا چند رقم اعشار در سلول ها نمایش داده شوند باید سلول یا سل

  Format Cellsراست کلیک کرده و گزینه   انتخاب کنید. روی آنها می خواهید تعداد رقم های اعشارشان را مشخص کنید،

  Number Formatبر روی آیکون   Numberبروید و از قسمت  Homeبه تب   هاپس از انتخاب سلول  نید یارا انتخاب ک

 کلیک کنید.

 
 در پنجره باز شده اعمال زیر را انجام دهید. 

 

1 

2 
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در   پس از انتخاب سلول های مورد نظر که دارای اعداد اعشاری هستند،  همچنین می توانید برای انجام سریع تر این کار

و برای افزایش رقم های اعشار بر     نآیکوروی  برای کاهش رقم های اعشار    ،Numberقسمت  و    Homeهمان تب  

  کلیک کنید.   روی آیکون

   قفل کردن سلول 5-6

به وجود آورند باید سلول های آن   آننتوانند تغییری در    بتوانند فایل اکسل شما را باز کنند ولی  اگر می خواهید دیگران 

را قفل کنید. در اکسل به صورت پیش فرض همه سلول ها قفل هستند ولی این قفل فعال نیست. برای فعال کردن قفل سلول ها  

را انتخاب کنید. در پنجره ای که باز می شود یک    Protect Sheet، گزینه  Changesبروید و از قسمت    Reviewبه تب  

،  Select Locked Cellsرمز برای زمانی که می خواهید قفل سلول ها را باز کنید، تعریف کنید و با برداشتن تیک گزینه  

ها به صورت    Sheetاین کار باید برای همه    اجازه ندهید کسی سلول های قفل شده را انتخاب کند و تغییری در آنها ایجاد کند.

 جداگانه انجام شود.

 
قفل می شوند ولی اگر می خواهید تعدادی از سلول ها قفل نشوند باید قفل   Sheetبا انجام این کار تمام سلول های این   

را برای آنها غیرفعال کنید. برای این کار محدوده ای از سلول ها که می خواهید قفل نشود را انتخاب کرده و روی آن راست  

کلیک کنید و تیک   Protectionرا انتخاب کنید. در پنجره باز شده بر روی تب   Format Cellsلیک کنید سپس گزینه  ک

 بردارید. را   Lockedگزینه  
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بروید و سایر گام های قفل کردن را به همان صورتی که در بالا گفته شد انجام دهید. در پایان   Reviewاکنون به تب  

 ، به جز سلول هایی که قفل را برای آنها غیرفعال کردید، قفل خواهند شد. Sheetهمه سلول های این 

 لینک سلول ها به یکدیگر   5-7

متفاوت لینک ایجاد کرد. با ایجاد   Sheetو یا حتی دو بخش از دو    Sheetدر اکسل می توان بین دو بخش از یک  

 لینک شما می توانید تنها با یک کلیک به سلول مورد نظر خود بروید. برای ایجاد لینک دو راه وجود دارد: 

بروید و از    Insert، به تب  Shapeرای ایجاد  مورد نظر لینک دهید. بد کنید و آن را به سلول  ایجا  Shapeیک    -1

دلخواه خود را انتخاب کنید و روی صفحه بکشید سپس    Shapeرا باز کنید،    Shapes، لیست آبشاری  Illustrationsقسمت  

مشخص کنید که می  در مرحله اول  را انتخاب کنید. در پنجره باز شده    Hyperlinkروی آن راست کلیک کرده و گزینه  

. در مرحله دوم مشخص یا به یک فایل اکسل دیگر  )مطابق شکل زیر(  به همین فایل اکسل لینک داده شود  Shapeین  خواهید ا

لینک بدهید را    Sheetکنید سلول مورد نظر شما در کدام   به آن  قرار دارد و در مرحله سوم آدرس سلولی که می خواهید 

 بنویسید.

 

1 2 

3 

4 
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ها عبارتی بنویسید، مثلا برای لینک نام بگذارید و... روی آن راست کلیک کرده و گزینه   Shapeبرای اینکه بتوانید در 

Edit Text .را انتخاب کنید. سپس عبارت دلخواه تان را در آن بنویسید 

برای این کار نام لینک را در سلول مورد نظر خود بنویسید سپس   یک سلول را به سلول مورد نظر خود لینک دهید.   -2

را انتخاب کنید. بقیه مراحل را مانند آنچه در بالا گفته شد ادامه دهید.پس  Hyperlinkروی آن راست کلیک کرده و گزینه 

 هد شد. از لینک دادن، نوشته داخل سلول با هر فونتی که باشد آبی رنگ می شود و زیر آن خط کشیده خوا

 
بروید و با استفاده از گزینه های قسمت   Homeدر صورتی که تمایل دارید این تنظیمات را تغییر دهید کافیست به تب  

Font.تنظیمات دلخواه خود را اعمال کنید ، 

 تغییر فرمت سلول   5-8

نوشتن بعضی داده  قرار دارد. این فرمت برای  Generalفرمت تمامی سلول های اکسل به صورت پیش فرض در حالت 

سلول وارد کنید، سلولی  در یک    8-10ها مناسب نیست و باید تغییر کند. مثلاً اگر شما بخواهید ساعت یک رویداد را به صورت  

که ابتدای آن    0915یا اگر بخواهید شماره ای به صورت *******  می دهد  آن را به عنوان تاریخ تشخیص  Generalبا فرمت  

برای   بنویسید، صفر ابتدای آن نشان داده نخواهد شد. (Generalا در یک سلول با فرمت پیش فرض )می شود ربا صفر شروع 

بروید    Homeراانتخاب کنید یا به تب    Format Cellsبر روی آن راست کلیک کرده و    برای دو مثال فوق  سلولفرمت  تغییر  

 کلیک کنید. در پنجره باز شده مسیر زیر را طی کنید. Number Format  آیکونروی    Numberو از قسمت 

 

1 

2 

3 
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 درج واحد در سلول به صورت خودکار  5-9

کالا در فایل اکسل هستید. اگر بخواهید به صورت دستی واحد   فرض کنید شما در حال وارد کردن قیمت تعداد زیادی

پول یعنی »ریال« را برای تمامی قیمت ها وارد کنید زمان زیادی به خاطر این کار از دست خواهد رفت. اکسل این امکان را برای  

 .شما به وجود آورده است که این واحد ها را به صورت خودکار در سلول ها درج کنید

کار واحد درج شود را انتخاب کنید، روی آنها راست کار سلول هایی که می خواهید برای آنها به صورت خود  برای این

انتخاب    Format Cellsکلیک کرده و گزینه     Format   بر روی آیکون  Numberقسمت    ،Homeکنید یا در تب  را 

Number  باز شده مسیر زیر را طی کنید.  کنید. در پنجرهکلیک 

 
ی اعداد است و در صورتی  جدا کردن سه رقم  برایدر کنار واحد نوشته شده است    Typeکه در قسمت    #,#عبارت  *

 که نمی خواهید اعدادتان به صورت سه رقم، سه رقم از هم جدا شوند می توانید این عبارت را ننویسید. 

 آنها را سه رقم، سه رقم نیز از هم جدا کرده است.مشاهده می کنید که واحد در کنار اعداد درج شده و 

1 

2 

3 

4 
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  به طور صحیح واحد باید در سمت چپ عدد قرار گیرد اما در اینجا در سمت راست عدد است. برای رفع این مشکل 

 مراحل زیر را انجام دهید.  سلول های دارای واحد خودکار را انتخاب کنید و

 

 تابع نویسی  -6

 تابع نویسی مقدمات  6-1

را با کاراکتر = شروع کنیم. کلیک کرده و آنسلولی که می خواهیم در آن تابع بنویسیم    روی  برای نوشتن توابع باید  -1

 مساوی در ابتدای سلول بدین معنی است که قرار است در آن سلول یک تابع نوشته شود.

کلیک کنید   Formula Barکلیک روی سلول، بر روی د بنابراین پس از  نوشته شو  Formula Barتابع باید در    -2

 تا تابع در آن نوشته شود.

 

1 2 

3 
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 برای تابع نویسی زبان صفحه کلید باید حتما لاتین باشد. -3

در نوشتن توابع مختلف به تعداد یک عدد یا بیشتر جداکننده استفاده می شود که در پیش فرض سیستم های مختلف،   -4

سیستم به دلخواه تغییر داد. عمومی ترین جداکننده    Control Panelداکننده ها را در قسمت  متفاوت است. می توان این ج 

 ( هستند.,( و );های پیش فرض )

 برای سلول های مجاور نیز اعمال می شود. Drag & Dropتابع نوشته شده در یک سلول با  -5

نوشته نشوند بلکه هر یک از اعداد مورد نظر را در یک    Formula Barدر تابع نویسی بهتر است خود اعداد در    -6

ولی    ها لینک می دهیمرا می نویسیم در واقع به سلول   که عدد در آن نوشته شده است  آن سلول  آدرس  سلول نوشته و در تابع 

در تابع فیکس نشوند  باید به این نکته توجه داشته باشید که آدرس سلول ها باید فیکس شوند. اگر آدرس سلول های نوشته شده  

تابع را برای سلول های مجاور اعمال می کنید، آدرس سلولی که عدد مورد نظر در آن نوشته    Drag & Dropزمانی که شما با  

 سلول های مجاور تغییر می کند و تابع درست عمل نخواهد کرد. شده و در تابع آمده است برای

 
در   $را فشار دهید تا دو علامت     F4برای فیکس کردن آدرس سلول در تابع کافیست روی آن کلیک کرده و کلید  

 نام سطر و ستون ظاهر شود. کنار
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تشخیص اینکه کدام .  یا فقط ستون آدرس سلول فیکس شود  لازم است فقط سطرمواقع  توجه داشته باشید که در بعضی از  

را دوبار فشار     F4شود به عهده شما است. برای فیکس کردن سطر در آدرس سلول کلید  فیکس  قسمت از آدرس سلول باید  

بار فشار دهید تا  را سه     F4در آدرس سلول کلید  ستون  فقط کنار نام سطر قرار گیرد و برای فیکس کردن    $دهید تا علامت  

 . قرار گیرد  ستونفقط کنار نام  $علامت 

ایجاد    ، علوم تجربی و زبان انگلیسیس ریاضیاتوبا استفاده از یک تابع نمراتی برای دربه عنوان مثال شما می خواهید  

این اعداد در سلول هایی که در شکل زیر نشان   کنید  باشند. فرض  16تا    13و    19تا    17،  12تا    10به ترتیب بین اعدادکنید که  

 داده شده است، نوشته می شود. 

 
 کنید.  Drag & Dropی هر سه ستون  تابع را بنویسید و آنرا برای سلول هابه دلخواه در یکی از سلول ها  
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در تابع نیاز به فیکس کردن   در آن نوشته شده اند،  اعداد  هایی که  می بینید که تابع درست عمل نمی کند و آدرس سلول

نید، آدرس سلول های اعداد هم به طرف چپ می رود و در  می ک  Drag & Dropزمانی که شما تابع را به طرف چپ  دارد.

رود(. این دقیقاً همان می    E13و    E12و سپس به    D13و    D12به    C13و    C12جا می شود )از سلول های  ستون ها جابه 

 کاری است که باید انجام شود پس در آدرس سلول های اعداد، ستون ها را فیکس نکنید.

 
می کنید، آدرس سلول های اعداد هم به طرف پایین تغییر می    Drag & Dropطرف پایین  زمانی که شما تابع را به  

 می رود(. C15و  C14و سپس به  C14 و C13به  C13و  C12جا می شود )از سلول بهکند و در سطرها جا 

 
سلول های خالی هستند و زمانی که تابع به آنها لینک داده شود، آنگاه آن تابع به درستی کار    C15و    C14سلول های   

را دوبار فشار دهید تا علامت    F4نخواهد کرد پس باید در آدرس سلول های اعداد، سطرها را فیکس کنید. برای این کار کلید 

 در کنار شماره سطر قرار گیرد و تابع به درستی عمل کند. $



 

27 
 

 
، تابع در سلولی که در آن نوشته شده است اعمال  Enterبا فشردن کلید     Formula Barپس از پایان نوشتن تابع در    -7

 می شود و حاصل آن یک عدد خواهد بود.

اول تابع خود اکسل   نیازی نیست کل تابع را بنویسید. با نوشتن چند حرف   Formula Barهنگام نوشتن تابع در    -8

)و یا فشردن با دوبار کلیک  با حروف نوشته شده را به شما پیشنهاد می دهد و شما می توانید تابع مورد نظر خود را  توابع هماهنگ  

 از میان آنها انتخاب کنید.از صفحه کلید(   Tabکلید 

 
 نشان دهنده توان است. )^(نشان دهنده ضرب و  (*) نشان دهنده تقسیم،  (/) در نوشتن توابع  -9

در صورتی که بخواهید روی اعداد چند سلول تغییری اعمال کنید مثلاً آنها را با یک عدد مشخص ضرب، تقسیم،   -10

، به صورت یک تابع بنویسید و برای بقیه  Formula Barجمع یا منها کنید می توانید برای یکی از سلول ها این تغییر را در  

 ضرب شوند.  2با عدد  Kکنید. برای مثال تمام اعداد ستون  Drag & Dropسلول ها  
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بگذارید در غیر این صورت تابع درست    "اگر بخواهید در توابع از عبارات فارسی استفاده کنید باید آنها را بین دو    -11

در تابع از آدرس آن    عمل نخواهد کرد و بهتر است برای انجام این کار عبارت فارسی مد نظر خود را در یک سلول بنویسید و

 سلول استفاده کنید.

 توابع   6-2

 Randbetweenتابع  6-2-1

   این تابع بین دو عدد صحیح دلخواه یک عدد صحیح تصادفی به شما می دهد و به صورت زیر نوشته می شود:

=Randbetween ( کوچکعدد   (عدد بزرگ ;
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ایجاد می شوند با انجام هر عملی در صفحه اکسل تغییر می کنند. در    Randbetween  تابعاعداد تصادفی که به وسیله  

واقع این تابع هربار که اکسل عملی انجام می دهد اعداد تصادفی جدیدی ایجاد می کند. اگر شما می خواهید که اعداد تصادفی 

اعداد را    Paste Valueکنید.    Paste Valueبه وجود آمده تغییر نکند می توانید از آنها کپی گرفته و در مکان مورد نظرتان  

 Pasteبدون تابع به مکان جدید منتقل می کند. برای انجام این کار کافیست در مکان مورد نظر راست کلیک کرده و گزینه  

Value .را انتخاب کنید 

 

 Sumتابع   6-2-2

 ته می شود:نوش  Formula Barبرای جمع کردن دو یا چند داده به کار می رود و به صورت زیر در 

=Sum ( خواهید با هم جمع شوندسلول هایی که می   ) 
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را    AutoSum، گزینه  Editingبروید و از قسمت    Homeبه تب  برای نوشتن این تابع راه دیگری نیز وجود دارد.  

 به صورت خودکار محدوده را نیز تشخیص می دهد. را می نویسد و  Sumتابع  AutoSum انتخاب کنید.

 

 Averageتابع  6-2-3

 از این تابع برای معدل گرفتن استفاده می شود و به صورت زیر نوشته می شود: 

=Average (سلول هایی که می خواهید از آنها معدل گرفنه شود) 

 
برای معدل گرفتن در اکسل راه دیگری نیز وجود دارد. شما می توانید جمع اعدادی که می خواهید از آنها معدل بگیرید 

تابعی بنویسید که این مجموع را تقسیم بر    Formula Bar( به دست آورده و در  AutoSum)یا    Sumرا با استفاده از تابع  

 تعداد اعداد کند و معدل به دست آید. 

 
 

1 
2 

3 
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توصیه می شود. چرا که اگر در محدوده انتخابی آن یک سلول   Averageدل استفاده از تابع  عمولا برای محاسبه معم

آنرا نه در مجموع و نه در تعداد به حساب نمی آورد و معدل صحیح را محاسبه می کند   Averageخالی وجود داشته باشد،  

صفر با سایر    آن را به عنوان عدد  Sumلی وجود داشته باشد، تابع  ( یک سلول خا/Sumولی اگر در محدوده انتخابی )تعداد

 اعداد جمع می کند و معدل به صورت غلط کاهش می یابد. 

 Randتابع  6-2-4

عمل می کند و بین دو عدد دلخواه یک عدد تصادفی به شما می دهد. با این تفاوت   Randbetweenاین تابع مثل تابع  

 به صورت زیر نوشته می شود: Rand. تابع  عدد به دست آمده یک عدد اعشاری خواهد بود که

=Rand ()*( عدد بزرگ -عدد کوچک    عدد کوچک  + (

 
 صفر و یک ایجاد خواهد کرد.  نوشته شود یک عدد تصادفی بین () Rand=به صورت  Randاگر تابع 
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 Ceilingتابع  6-2-5

از این تابع برای رند کردن اعداد اعشاری استفاده می شود. در این تابع یک مقدار به عنوان مقدار معناداری اعشار تعیین 

مقدار معناداری تعیین   به عنوان 0.50می شود و تمام اعداد اعشاری بر اساس آن مقدار، رند می شود )معنادار می شود( مثلاً اگر 

است،    7.50نزدیک تر از عدد    8معنادار نیست و چون مقدار آن به عدد    7.834567معنادار هستند ولی عدد    8و    7.50شود اعداد  

 رند می شود. این تابع به صورت زیر نوشته می شود:  8به عدد 

=Ceiling (مقدار معناداری اعشار ;عدد اعشاری) 

به دست می آید، باید دو تابع را با یکدیگر ترکیب    توابع اعداد اعشاری که از  برای    Ceilingجهت اعمال کردن تابع  

 کنید. مثلاً 

=Ceiling (Rand ()*( عدد بزرگ   -عدد کوچک   (مقدار معناداری اعشار  ;عدد کوچک  + (

                  

 

 Randحاصل از تابع  عدد اعشاری



 

33 
 

 Roundتابع  6-2-6

به   Roundبا استفاده از این تابع شما می توانید مشخص کنید که اعداد اعشاری تا چند رقم اعشار نشان داده شوند. تابع  

 صورت زیر نوشته می شود: 

=Round ( تعداد رقم های اعشار ;عدد اعشاری) 

به دست می آید، باید دو تابع را با یکدیگر ترکیب توابع  اعداد اعشاری که از  برای    Roundجهت اعمال کردن تابع  

 کنید. مثلاً 

=Round (Average (سلول هایی که می خواهید از آنها معدل گرفنه شود); تعداد رقم های اعشار) 

                

 
، راه دیگری نیز وجود Roundهم گفته شد برای تعیین تعداد رقم های اعشار علاوه بر تابع    5-5همان طور که در قسمت  

پذیر می  امکان  تنظیمات مربوطه  و انجام    Format Cellsدارد که با راست کلیک روی سلول های مورد نظر، انتخاب گزینه  

برای یک سلول، اگر عدد نوشته شده    Format Cellsت استفاده از گزینه  باشد. تفاوت این دو راه در این است که در صور

 عدد صحیح را بدون صفر نمایش می دهد. Roundنوشته می شود ولی تابع  15.00در آن یک عدد صحیح باشد به صورت 

 Ifتابع   6-2-7

ثلاً اگر معدل فردی بزرگتر یا  از این تابع زمانی استفاده می شود که بخواهید یک شرط را به صورت فرمول بنویسید. م

 Ifبود، آنگاه در مقابل اسمش کلمه »متوسط« و در غیر این صورت در مقابل اسمش کلمه »ضعیف« نوشته شود. تابع    12مساوی  

 به صورت زیر نوشته می شود:

=If ( یشرط منطق  (در غیر این صورت ;(آنگاه) جواب شرط ;(اگر) 

 Averageحاصل از تابع  عدد اعشاری
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 Ifچندین تابع  ترکیب  کنید، خود از چندین شرط تشکیل شده باشد باید از    اگر شرطی که می خواهید آن را فرموله

بود، آنگاه در مقابل اسمش کلمه »عالی«، در غیر این صورت اگر معدل    17استفاده کنید. مثلاً اگر معدل فردی بزرگتر یا مساوی  

صورت مقابل اسمش کلمه »مشروط« نوشته  بود، آنگاه در مقابل اسمش کلمه »متوسط« و در غیر این    12او بزرگتر یا مساوی  

 بنویسید.  Ifتابع  12تابعی با ترکیب حداکثر در صورت نیاز شما می توانید  شود.

 

 Countتابع  6-2-8

 برای شمارش اعداد به کار می رود و به صورت زیر نوشته می شود:  Countتابع 

=Count ( شودمحدوده سلول هایی که می خواهید اعداد آن شمرده  ) 

 فقط تعداد اعداد را می شمارد و توانایی شمارش سایر انواع داده ها را ندارد. Countتابع 
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 Count Ifتابع  6-2-9

 Countاین تابع زمانی به کار می رود که شما بخواهید در یک محدوده از داده ها تعداد یکی از داده ها را بشمارید. تابع  

If :به صورت زیر نوشته می شود 

=Count If ( مورد نظر محدوده   (داده ای که می خواهید تعداد آن را بشمارید ;

 را دارد. توانایی شمارش همه انواع داده ها  Count Ifتابع 
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 Modeتابع  6-2-10

این داده دارای بیشترین    Modeمدِ یک محدوده، عددی است که دارای بیشترین فراوانی در آن محدوده است و تابع  

 به صورت زیر نوشته می شود: Modeفراوانی را به شما معرفی می کند. تابع 

=Mode ( آوریدمحدوده ای که می خواهید مد را در آن به دست  )  

 
فقط داده ای با بیشترین فراوانی را به شما معرفی می کند و اگر بخواهید بدانید فراوانی آن چند است می    Modeتابع  

 استفاده کنید.  Count Ifتوانید از تابع 

=Count If (محدوده مورد نظر; Mode (محدوده مورد نظر)) 

                                          

 

 محدوده مورد نظرمد 
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 Maxتابع   6-2-11

 به صورت زیر نوشته می شود:  Maxاین تابع بزرگترین عدد در محدوده مد نظر شما را مشخص می کند. تابع 

=Max (محدوده که می خواهید بزرگترین عدد آن را مشخص کنید) 

 

 Minتابع  6-2-12

 به صورت زیر نوشته می شود: Minاین تابع کوچکترین عدد در محدوده مد نظر شما را مشخص می کند. تابع  

=Min (محدوده که می خواهید کوچکترین عدد آن را مشخص کنید) 
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 Rankتابع  6-2-13

ک محدوده در مقایسه با سایر ، تابع رتبه بندی است. با استفاده از این تابع شما می توانید رتبه یک عدد را در ی Rankتابع  

 اعداد آن محدوده به دست آورید. این تابع به صورت زیر نوشته می شود:

=Rank ( 1یا0 ;محدوده ای که می خواهید رتبه عدد را در آن مشخص کنید ;عددی که رتبه آن را می خواهید) 

 ، اکسل دو گزینه به شما ارائه می دهد. Rankدر بخش آخر نوشتن تابع 

 
اگر صفر را انتخاب کنید، رتبه بندی از بزرگ به کوچک انجام خواهد شد و عدد بزرگتر، رتبه بیشتری خواهد داشت. 

 اگر یک را انتخاب کنید رتبه بندی از کوچک به بزرگ انجام خواهد شد و عدد کوچکتر، رتبه بیشتری خواهد داشت.
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  Drag & Dropرا برای آنها    Rankاگر بخواهید رتبه سایر داده های محدوده مورد نظر را نیز مشخص کنید، باید تابع  

 کنید. توجه داشته باشید که در این صورت حتماً باید آدرس محدوده را در تابع فیکس کنید.

 

 توابع ماتریسی  6-3

 باشد.  Left to Rightتوابع ماتریسی صفحه اکسل باید به صورت در  -1

 سلول محدوده جواب نوشته می شوند. توابع ماتریسی در اولین -2

ت آید، تابع فقط سلول اول محدوده جواب دارای عدد می شود. برای اینکه کل محدوده جواب به دسنوشتن پس از  -3

به    Ctrl + Shift + Enterدهید و سپس کلیدهای  را فشار    F2تمام محدوده جواب را گرفته کلید   باید طور همزمان را 

 بفشارید.

 تابع ضرب ماتریس 6-3-1

برای ضرب آنها مشکلی   باشنداگر دو ماتریس مربعی و هم اندازه این تابع ماتریس دو ماتریس را در هم ضرب می کند. 

س دوم برابر باشد تا بتوان آن دو  ولی اگر مربعی و هم اندازه نباشند باید تعداد سطر ماتریس اول با تعداد ستون ماتری  وجود ندارد 

 به صورت زیر نوشته می شود: در اولین سلول محدوده جواب تابع ضرب ماتریس را با هم ضرب کرد.

=mmult (ماتریس اول; دوم ماتریس  ) 
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 تابع ماتریس ترانهاده  6-3-2

 صورت زیر نوشته می شود:جا می کند و به این تابع داده های افقی و عمودی یک ماتریس را با هم جابه 

=transpose (ماتریس مورد نظر) 

 

 تابع معکوس ماتریس 6-3-3

 این تابع معکوس یک ماتریس را به دست می آورد و به صورت زیر نوشته می شود:

=minverse ( مورد نظرماتریس  ) 
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 تابع دترمینان ماتریس 6-3-4

که یک عدد است را به شما می دهد. بنابراین برای به دست آوردن جواب آن نیازی  دترمینان یک ماتریس    ،این تابع

 به صورت زیر نوشته می شود:  استفاده شود. تابع دترمینان ماتریس  F2  ،Ctrl  ،Shift  ،Enterتوابع از کلید های  نیست مثل سایر  

=mdeterm ( مورد نظرماتریس  ) 

 

 تابع جمع ماتریس 6-3-5

پس از وارد کردن مساوی، محدوده   Formula Barجمع دو ماتریس نیاز به تابع خاصی ندارد فقط کافی است در  

 کنید سپس یک علامت جمع وارد کنید و محدوده ماتریس دوم را انتخاب کنید. ماتریس اول را انتخاب 

 ماتریس دوم  + ماتریس اول=

 

 قید و شرط با  سلول   فرمت تعیین -7

7-1  Conditional Formatting 

است که فرمت سلول ها را به صورت   Ifتابع    مشابه   نوعیبه    Conditional Formatting  می توان گفت  در واقع 

، فرمت سلول ها را تعیین کنید می توانید از  داریددر صورتی که شما بخواهید متناسب با اعدادی که  تعیین می کند.    مشروط

Conditional Formatting  فاده کنید. مثلاً شما تعدادی معدل دارید و می خواهید سلول نام کسانی که معدل بزرگتر یا  است

دارند قرمز    12دارند زرد رنگ و کسانی که معدل پایین تر از    12، کسانی که معدل بزرگتر یا مساوی  سبز رنگ  دارند  17مساوی  
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 )در این مثال سلول های نام افراد(   فرمت مشروط تعیین کنید  هاکه می خواهید برای آن   سلول هایی ابتدا    رنگ باشد. برای این کار

 : مسیر زیر را طی کنید را انتخاب نمایید و سپس

Home → Styles → Conditional Formatting → New Rule 

را انتخاب نمایید و در   Use a formula to determine which cells to formatدر پنجره باز شده ابتدا گزینه  

 : استشرط منطقی جمله زیر  به صورت فرموله بنویسید. در مثال فوق اولینمشخص شده شرط منطقی )اگر( را  کادر

 .«باشد 17تر یا مساوی معدل بزرگ»اگر 

. در این  پس طبق قوانین نوشتن تابع ابتدا مساوی را در کادر وارد کنید و سپس اولین سلول از ستون معدل را انتخاب کنید

س می شوند ولی شما علامت فیکس را برای سلول معدل بردارید تا شرطی که  ها به طور خودکار فیک  قسمت آدرس سلول

فرموله می کنید برای تمام سلول های معدل لحاظ شود نه فقط سلولی که انتخاب کرده اید. در این شرط، معدل باید بزرگتر یا  

در آن نوشته شده است را انتخاب کنید. همان طور که می    17را نوشته و سلولی که عدد    (=<)باشد پس علامت    17مساوی  

 کلیک کنید تا جواب شرط )آنگاه( را تعریف کنید.   Formatسپس بر روی گزینه    باید فیکس شود.  17دانید آدرس سلول  

 جواب شرط در مثال فوق جمله زیر است: 

 »آنگاه سلول نام افراد سبز رنگ شود.«

 
فرمت دلخواه خود را  ،  دارنددر پنجره باز شده شما می توانید برای سلول هایی که شرط تعریف شده در مرحله قبل را  

سلول نام افراد سبز رنگ  فرمت دلخواه این است که    بودن معدل،  17در صورت بزرگتر یا مساوی  انتخاب کنید. در مثال فوق  

  شود:شود پس مراحل زیر طی می  

1 

2 3
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پس از انجام مراحل فوق شما دوباره به پنجره قبلی باز می گردید و شرط منطقی و جواب آنرا در کنار هم مشاهده می  

 کنید.  

 
 کلیک کنید تا فرمت مورد نظر برای سلول هایی که شرط تعریف شده را دارند، اعمال شود.  OKبر روی گزینه  

1 

2

3 
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باشد، آنگاه سلول نام افراد زرد   12معدل بزرگتر یا مساوی    )اگر  برای همان سلول های نام افراد  بعدیجهت تعریف شرط  

 رنگ شود.( دوباره آنها را انتخاب نمایید و مراحل زیر را طی کنید:

Home → Styles → Conditional Formatting → Manage Rules 

 نید.کلیک ک New Ruleدر پنجره باز شده بر روی گزینه 

 
 کنید.کلیک  OKمانند شرط اول تعریف کنید و روی گزینه  شرط دوم را نیز دقیقاً
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کلیک کنید تا شرط سوم   New Ruleحال هردو شرط تعریف شده برای سلول نام افراد را می بینید. دوباره روی گزینه  

 باشد، آنگاه سلول نام افراد قرمز رنگ شود.(  12معدل کوچکتر از  هم برای همان سلول های نام افراد تعریف کنید. )اگررا  

 
شرط سوم را هم مشابه دو شرط قبلی تعریف کنید با این تفاوت که در شرط سوم در نوشتن فرمول باید از علامت کوچکتر 

 کنید.را انتخاب   OKاستفاده کنید. سپس گزینه  (>)

 
همان طور که می بینید سه شرط مثال فوق به طور کامل تعریف شده اند اما ترتیب اولویت آنها درست نیست و اگر با این 

درست عمل نخواهد کرد و اعداد بالای    Conditional Formattingکلیک کنید،    OKیا    Applyترتیب بر روی گزینه  

 را نیز زرد رنگ خواهند شد. 17
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جابه جا کنید. همچنین باید    و   ولویت شرط ها، می توانید آنها را با استفاده از آیکون های برای اصلاح ترتیب ا

 را برای همه شرط ها به جز شرط آخر فعال کنید.  Stop If Trueتیک گزینه 

 
 کلیک کنید. OKیا   Applyدر نهایت روی گزینه 

 

1 

2 

3 
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7-2  Icon Set 

Icon Set در کنیدرا تعیین فرمت سلول ها  به صورت مشروط، است که شما می توانید  راه هایی  یکی دیگر از .Icon 

Set    قبلاً برای آن تعریف کرده  صدق کند، آیکونی که شما    یکی از شروطشما شروطی را تعریف می کنید و در هر سلولی که

 نمایش داده می شود.  اید،

د باشد بنابراین باید اعدادی که شرط را بر اساس نمایش داده می شوند که دارای عد  ، آیکون ها در سلولیIcon Setدر  

  شروط بر اساس معدل تعیین می شوند   7-1. مثلاً در مثال قسمت  بنویسید  Icon Set  های   در سلولآنها تعیین می کنید، را دوباره  

استفاده کنیم، باید اعداد ستون معدل را در    Icon Setباشد، آنگاه ...( پس اگر بخواهیم از    17اگر معدل بزرگتر یا مساوی  )

ستون دیگری کپی کنیم اما این کار زمانی که معدل ها مدام تغییر می کنند می تواند باعث بروز تناقض و اشتباه شود. روش ساده  

فیست اولین سلول از ستون  . کااستدیگری نیز وجود دارد که از بروز اشتباه جلوگیری می کند و آن استفاده از یک فرمول ساده  

Icon Set    را انتخاب کنید و درFormula Barعدل را با کلیک روی آن  م  ، مساوی را نوشته سپس اولین سلول از ستون

  Icon Set  ،Drag & Dropآدرس سلول در این فرمول را فیکس نکنید و آنرا برای تمام سلول های ستون  تخاب کنید.  ان

ستون معدل برابر است و هر تغییری در ستون  سلول های  با    Icon Setستون  سلول های  بدین معنی است که  این فرمول    کنید.

 سلول از لحاظ فرمولی لینک برقرار کردید. نیز اعمال می شود. در واقع شما بین دو Icon Setمعدل در ستون 

که معدل ها در آن   Icon Setدارید و فقط کافیست ستون  را    Icon Setاکنون شما پیش نیاز لازم برای استفاده از  

 نوشته شده است را انتخاب کنید و مسیر زیر را طی کنید:

Home → Styles → Conditional Formatting → Icon Sets 

ها که تعداد آیکون هایش با تعداد شرط های    Icon Setتعداد شروطی که می خواهید تعریف کنید، یکی از  با توجه به  

 شما برابر است را به دلخواه انتخاب کنید. 

 

1 2

3 

4 
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درست عمل نمی کند و برای بعضی از معدل های متوسط آیکون عالی یا مشروط را نشان می   Icon Setکه    بینیدمی  

، روی  Icon Setsآن است که شما هنوز شرط های خود را تعریف نکرده اید. برای تعریف شرط ها در  دهد. دلیل این اتفاق  

 کلیک کنید.  More Rulesگزینه 

 
  Icon Styleرا انتخاب کنید. در قسمت    Format all cells based on their valuesدر پنجره باز شده گزینه  

نشان داده نشوند، تیک گزینه    Icon Setدوباره آیکون های دلخواه خود را انتخاب کنید و اگر می خواهید اعداد در ستون  

Show Icon Only   .را نیز فعال کنید 

 

1 

2 
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 دهید. تغییر  Numberبه   Percentرا از  Typeاکنون باید شروط خود را مشخص کنید. برای این کار ابتدا 

 
 شروط عبارتند از: 

در سلول نشان داده شود، در غیر این صورت زمانی که    باشد، آنگاه آیکون    17که معدل بزرگتر یا مساوی      »زمانی 

در سلول نشان   در سلول نشان داده شود و در غیر این صورت آیکون   باشد، آنگاه آیکون   12معدل بزرگتر یا مساوی 

 داده شود.«

 

1 

2 
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 به درستی عمل می کند. Icon Setرا بزنید. می بینید که   OKدر نهایت 

 

 در اکسل  نمودار -8

 رسم نمودار 8-1

ار دست  برای رسم نمودار ابتدا باید داده هایی که قرار است بر اساس آنها نمودار رسم شود را در اکسل وارد کنید. نمود

کم دارای دو متغیر است بنابراین باید داده های مربوط به حداقل دو متغیر را در اکسل وارد کنید و سپس اقدام به کشیدن نمودار  

 نمایید.

را نگه دارید و داده های مربوط به متغیر دوم را نیز انتخاب   Ctrlداده های مربوط به متغیر اول را انتخاب کنید سپس کلید  

 نمایید. ادامه مسیر را مطابق شکل زیر دنبال کنید. 

 

2 

1 
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Recommended Chartsپیشنهاد می دهد و بهتر   ، نمودار هایی هستند که اکسل بر اساس نوع داده های شما، آنها را

پنجره زیر باز می شود که  Recommended Chartsن آنها انتخاب کنید. پس از کلیک بر روی است نمودار خود را از میا

 می توانید در آن نوع نمودار مد نظر خود را مشخص کنید.

 

 

 نمایش مقدار دقیق داده های نمودار روی آن   8-2

اگر بخواهید مقدار دقیق هر کدام از داده ها روی بخش مربوط به خودش نمایش داده شود، باید بر روی نمودار کلیک  

کنید. کلیک  Designبر روی تب  Chart Toolsکنید تا تب های مربوط به ویرایش نمودار نشان داده شود سپس از قسمت 

لیست آبشاری  Chart Layoutsدر بخش    ،Add Chart Element  با را روی گزینه  را  نشانگر ماوس   Dataز کنید. 

Labels  .نگه دارید تا انواع نمایش داده ها بر روی نمودار نشان داده شود سپس از بین آنها گزینه دلخواه خود را انتخاب کنید 
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نمودار نشان داده می  برای این کار راه دیگری نیز وجود دارد. روی نمودار کلیک کنید، با این کار چند آیکون کنار  

را بزنید سپس مانند شکل زیر    Chart Labelsکلیک کنید و تیک گزینه      Chart Elements  شوند. بر روی آیکون

 عمل کنید.

 

 نمودار  و نوشته های فارسی کردن اعداد 8-3

 برای فارسی کردن اعداد نمودار روی اعداد راست کلیک کرده و گام های زیر را انجام دهید. -1
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 در پنجره باز شده، مسیر زیر را دنبال کنید. 

 
برای فارسی کردن سایر اعداد مثل مقدار داده های نمودار که روی آن نوشته شده است نیز باید دقیقا همین مسیر را طی 

ردن همگی فونت های فارسی هستند و شما می توانید برای فارسی ک  Fکنید. همچنین توجه داشته باشید که فونت های سری  

 اعداد به دلخواه هر کدام را انتخاب کنید. 

 Homeبرای فارسی کردن عبارات نوشته شده در نمودار مثل متون معمولی کافیست روی آنها کلیک کرده و در تب    -2

 ( برای آنها انتخاب کنید. 2یا   B، یک فونت فارسی )سری Fontقسمت 
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 جا به جا کردن محور های نمودار 8-4

کردن محور عمودی نمودار باید روی محور عکس آن یعنی محور افقی راست کلیک کرده و اعمال زیر برای جا به جا 

 را انجام دهید. 

 
 Categories in reverseکه در سمت راست صفحه ظاهر می شود، گزینه ای به نام    Format Axisدر پنجره  

order  قرار می گیرد و در صورتی که تیک را بردارید    وجود دارد که اگر تیک آن را بزنید محور عمودی در سمت راست

 محور عمودی در سمت چپ قرار می گیرد.

 
برای جا به جا کردن محور افقی نمودار نیز باید روی محور عکس آن یعنی محور عمودی راست کلیک کرده و گزینه  

Format Axis   را انتخاب کنید. سپس در در پنجرهFormat Axis   که در سمت راست صفحه ظاهر می شود، گزینه ای به

زنید محور افقی در بالا قرار می گیرد و در صورتی که تیک  وجو دارد که اگر تیک آن را ب  Values in reverse orderنام  

 را بردارید محور عمودی در پایین قرار می گیرد.
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 تغییر اطلاعات نمودار پس از رسم آن   8-5

زمانی که روی نمودار کلیک کنید، محدوده داده هایی که بر اساس آنها نمودار رسم شده است نشان داده می شود. شما 

ن داده ها را کم و زیاد کنید یا به کلی محدوده آن ها را تغییر دهید. برای کم و زیاد کردن داده ها پس از کلیک  می توانید ای

است کلیک کنید، نگه دارید و به سمت دلخواه بکشید   روی نمودار، در جایی از محدوده داده ها که نشانگر ماوس به شکل  

 تا محدوده بزرگ یا کوچک شود. 

 
جا کنید. بنابراین پس از کلیک روی نمودار، در جایی از محدوده داده ها که  ی تغییر داده ها باید محدوده آن را جابه برا

 جا شود و داده ها تغییر کند. است کلیک کنید، نگه دارید و به سمت دلخواه بکشید تا محدوده جابه  نشانگر ماوس به شکل  

1 

2 
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9- Sort  داده ها و فیلتر کردن   کردن 

9-1 Sort  )... کردن )مرتب کردن بر اساس 

اگر در اکسل جدولی از داده ها دارید که می خواهید بر اساس قاعده ای معین )مثلا از بزرگ به کوچک یا بر اساس 

نتخاب کنید و سپس مطابق کنید. برای این کار ابتدا باید کل محدوده داده ها را ا  Sortحروف الفبا( مرتب شوند، باید آنها را  

 شکل زیر عمل کنید.

 

 

 

 

 

 

 

 

تی که داده های شما دارای عنوان )سربرگ(  پنجره زیر باز می شود. در صور  Custom Sortپس از انتخاب گزینه  

 بردارید. بزنید، در غیر این صورت تیک این گزینه را را   My data has headersهستند تیک گزینه  

1 

2 

1 
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شما مشخص می کنید که بر اساس کدام ستون از داده ها می خواهید کل داده هایتان را مرتب   Sort byدر قسمت  

کنید)مثلا بر اساس معدل که دارای چه وضعیتی است، کلیه داده ها مرتب شوند(. اگر در مرحله قبل تیک را فعال کرده باشید  

ه می شود و در صورتی که تیک را فعال نکرده باشید نام ستون هایی که داده ها در آن  در این قسمت عنوان داده ها نمایش داد

  نوشته شده اند، نمایش داده می شود.

 
 چگونگی مرتب سازی مشخص می شود)مثلا از بزرگ به کوچک(. Orderدر قسمت 

 

2 

1

1 

2
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به   در میان داده ها وجود   19.50یکدیگر شبیه بودند )مثلا چندین معدل  اگر داده هایی که مبنای مرتب سازی هستند 

داشت( شما می توانید مبنای دیگری هم برای مرتب سازی تعریف کنید. توجه داشته باشید که اگر داده ها شبیه به هم نبودند 

 اصلاً از مبنای دوم استفاده نمی شود. برای این کار مانند شکل زیر عمل کنید.

 
ی که داده هایی را اساس و مبنای مرتب سازی قرار داده باشید و بخواهید آن را حذف کنید کافیست آنرا انتخاب در صورت 

 کلیک کنید. Delete Levelکرده و بر روی گزینه  

   فیلتر کردن  9-2

یا پایین   معدل آنها بالاتر فیلتر کردن به نوعی غربال کردن داده هاست. مثلاً شما می خواهید فقط نام کسانی را ببینید که  

است. برای فیلتر کردن ابتدا باید محدوده داده هایی که می خواهید بر اساس آنها فیلتر را انجام دهید، انتخاب کنید )مثلا    10از    تر

 را ببینید، باید ستون معدل ها را انتخاب کنید(.   10اگر می خواهید معدل های بالای 
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59 
 

روی اولین سلول از ستون داده های انتخاب شده علامت لیست آبشاری نمایش داده    Filterپس از کلیک بر روی گزینه  

می شود که در شکل فوق نشان داده شده است. روی آن کلیک کنید. در لیست آبشاری باز شده نشانگر ماوس را روی گزینه  

Number Filters  خاب کنید. مثلاً اگر می خواهید کسانی که معدل آنها دقیقاً برابر عدد  نگه دارید و نوع فیلتر خود را انت

کنید یا اگر می خواهید کسانی که معدل آنها کمتر از عدد مشخصی کلیک    Equalsمشخصی است را ببینید بر روی گزینه  

ب می کنیم چون می خواهیم  را انتخا Greater Thanکنید. در اینجا ما گزینه ا انتخاب ر  Less Thanاست را ببینید، گزینه  

 معدل های بیشتر از یک عدد مشخص نشان داده شود.

 
در پنجره باز شده عددی که می خواهید معدل های بالاتر یا پایین تر یا برابر یا ... آن نشان داده شوند را بنویسید. در اینجا 

 را می خواهیم. 10ما معدل های بالاتر از 

 

2 
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برای از بین بردن فیلتر، قسمت هایی را که فیلتر کرده اید انتخاب کنید سپس مانند زمانی که آن را ایجاد کردید در تب 

Home   روی گزینهSort & Filter  کلیک کنید و آیکونFilter   .را غیر فعال کنید 

10- Data Validation 

Data Validation    .به شما اجازه می دهد تا بدانید داده هایی که در اکسل وارد می کنید، صحیح و معتبر هستند یا خیر

معتبر نمی باشند.   20باشند و نمرات زیر صفر و بالای    20  تامثلاً درباره نمرات دانش آموزان یک مدرسه اعداد باید بین صفر  

ه مورد نظر خود را انتخاب کنید که در مثال فوق محدوده مورد نظر، ابتدا باید محدود   Data Validationبرای استفاده از  

در   کنید.کلیک    Data Validation، روی گزینه  Data Toolsبروید و از بخش    Dataمحدوده نمرات است. سپس به تب  

چون    این مثال  درمشخص کنید که چه نوع داده هایی مجاز هستند که در محدوده نوشته شوند.    Allowپنجره باز شده در کادر  

  علاوه بر اعداد صحیح،   )اعشاری( انتخاب می شود تا بتوانیم  Decimalممکن است نمرات دانش آموزان اعشاری باشند گزینه  

 را در قسمت نمرات وارد کنیم.  نیز اعداد اعشاری

 

1 
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تواند باشد. در مثال فوق حداقل و حداکثر مجاز  حال باید مشخص کنید که حداقل و حداکثر مجاز داده ها چقدر می  

 است. دقت کنید که آدرس سلول های حداقل و حداکثر را فیکس کنید.  20داده ها، صفر و 

 
شما می توانید یک پیام تعریف کنید تا زمانی که سلول های محدوده مورد نظر انتخاب شدند   Input Messageدر تب  

 ، متن پیام را بنویسید.Input messageپیام و در قسمت عنوان  ،Titleت آن پیام نمایش داده شود. در قسم
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، می توانید هشداری تعریف کنید تا زمانی که داده غیرمعتبری در یکی از سلول های محدوده وارد  Error Alertدر تب  

می توانید یکی از آنها را انتخاب   ، سه نوع پیام هشدار وجود دارد کهStyleشد، آن هشدار نمایش داده شود. در لیست آبشاری  

به کاربر هشدار می دهد و از او می پرسد که می    Warningبه هیچ وجه اجازه ورود داده نامعتبر را نمی دهد،    Stopکنید.  

مت  فقط به کاربر اطلاع می دهد که این داده نامعتبر است. در قس Informationخواهد این داده نامعتبر را وارد کند یا نه ولی 

Title،  هشدار و در قسمت عنوانError message متن هشدار را بنویسید و سپس گزینه ،OK  .را انتخاب کنید 
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 قفل کردن فایل اکسل  -11

   F12در صورتی که بخواهید دیگران نتوانند فایل اکسل شما را باز کنند باید برای آن رمز بگذارید. برای این کار کلید  

را از صفحه کلید خود بفشارید. در پنجره ای که باز می شود ابتدا مکانی که می خواهید فایل اکسل در آنجا ذخیره شود را  

 دهید. انتخاب کنید سپس اعمال زیر را انجام 

 
چیزی    Password to modifyدر این مرحله، در قسمت مشخص شده رمز دلخواه خود را وارد کنید و در کادر  

 ننویسید.

 
 رمز را دوباره وارد کنید.
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 کلیک کنید تا فایل اکسل شما با رمز در مکان دلخواه تان ذخیره شود. Saveو در نهایت روی گزینه 

 کردن سطر و ستون  فریز -12

شما می توانید سطر، ستون یا هردو را در یک صفحه اکسل فریز کنید. اگر شما یک سطر یا ستون را فریز کنید، هر جای  

 صفحه اکسل که باشید آن سطر یا ستون نمایش داده خواهد شد.

 برای فریز کردن اولین سطر صفحه مسیر زیر را طی کنید:

 View → Window → Freeze Panes → Freeze Top Row 

 برای فریز کردن اولین ستون صفحه مسیر زیر را طی کنید:

View → Window → Freeze Panes → Freeze First Colum 

آزادی عمل بیشتری به شما می دهد و شما می توانید هر تعداد سطر یا ستون یا هردو را با استفاده  Freeze Panes گزینه  

کار ابتدا باید سلولی را انتخاب کنید که می خواهید سطرهای بالای آن و ستون های سمت راست آن  از آن فریز کنید. برای این  

 فریز شوند سپس مسیر زیر را طی کنید:

View → Window → Freeze Panes → Freeze Panes 

 یر را انجام دهید. را انتخاب کنید و مراحل ز  B2مثلاً اگر فریز کردن سطر اول و ستون اول مد نظر باشد، باید سلول 

 
 می بینید سطر اول و ستون اول فریز شده اند و چه به سمت پایین برویم و چه به سمت چپ همیشه نشان داده خواهند شد.
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 برای از بین بردن فریز نیز کافیست مسیر زیر را طی کنید: 

View → Window → Freeze Panes → Unfreeze Panes 

برای از بین بردن فریز، به جای گزینه    Unfreeze Panesزمانی که سطر یا ستونی را در صفحه اکسل فریز کنید، گزینه  

Freeze Panes    ظاهر می شود و در صورتی که سطر یا ستونی را فریز نکرده باشید گزینهUnfreeze Panes    نشان داده

 نمی شود.

 Comment تنظیمات -13

 Commentگذاشتن   13-1

استفاده می شود که فردی بخواهد بدون ایجاد تغییری در فایل اکسل شما، نظراتش را درباره آن   Commentزمانی از  

کافیست سلول یا محدوده ای از سلول ها که می خواهید درباره آن نظر بدهید را انتخاب  Commentبیان کند. برای گذاشتن 

 را انتخاب کنید. Insert Commentید سپس گزینه کرده و روی آن راست کلیک کن
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  Commentتغییر اندازه کادر و تنظیمات متن  13-2

، با توجه به تعداد کلمات نظری که می خواهید بنویسید کافیست در جایی از کادر  Commentبرای تغییر اندازه کادرِ  

  Comment. تنظیمات متن  و رها کنید  نگه دارید و تا اندازه دلخواه خود بکشید  نید،کلیک کاست  که نشانگر موس به شکل

 تغییر دهید. Fontو قسمت  Homeرا نیز می توانید در تب  
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   Commentنشان دادن و پنهان کردن   13-3

  راست کلیک کنید و گزینه   Commentگذاشته شده همیشه نشان داده شود، روی سلول    Commentاگر می خواهید  

Show/Hide Comment را انتخاب نمایید. 

 
انتخاب نشده است،   Commentهمیشه نشان داده می شود و می خواهید تا زمانی که سلول دارای     Commentاگر  

Comment  نشان داده نشود، روی آن سلول راست کلیک کنید و گزینهHide Comment  .را انتخاب نمایید 

 

1 

2 

1 
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 Commentویرایش  13-4

 را انتخاب نمایید.  Edit Comment، روی سلول آن راست کلیک کنید و گزینه Commentبرای ویرایش 

 

 Commentحذف   13-5

 را انتخاب کنید.   Delete Commentنیز کافیست مثل قبل روی سلول آن راست کلیک و   Commentبرای حذف  

14- Form 

Form   .به شما در وارد کردن داده ها به صورت دستی سرعت می بخشد نرم افزار اکسل است که  امکانات  یکی از 

Form    فقط برای داده هایی که به صورت افقی )سطری( نوشته می شوند کاربرد دارد. به صورت پیش فرض این بخش در

 مسیر زیر را طی کنید:  Formعال کنید. برای فعال کردن را ف Formاکسل غیرفعال می باشد و برای استفاده از آن ابتدا باید 

File → Options → Customize Ribbon 

آبشاری   لیست  باز شده  پنجره  گزینه    Choose commands fromدر  و  باز کرده   Commands Not inرا 

Ribbon .را انتخاب کنید 

1 

2 
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کنید تا تب کلیک    New Tabرا انتخاب کنید. سپس روی گزینه    Formدر کادر پایین از بین گزینه های موجود،  

 را انتخاب کنید.  Addجدیدی به وجود بیاید و در نهایت 

 
 کلیک کنید.  OKدر تب جدید ظاهر می شود سپس روی گزینه  Formمشاهده می کنید که گزینه 

1 3 

2 

1 

2 
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در وارد کردن داده های افقی، ابتدا جدول خالی داده هایی که می خواهید به صورت دستی    Formبرای به کار گرفتن  

 وارد کنید را آماده کنید.
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 .کنیدرا انتخاب   Formگزینه  New Tabسپس محدوده این جدول را انتخاب کرده و در  

 
  Tabدر پنجره باز شده داده های مربوط به سطر اول را وارد کنید. می توانید برای افزایش سرعت کار با استفاده از کلید  

 جا شوید. موجود در صفحه کلیدتان بین کادرها جابه 

 
 بفشارید تا داده ها ثبت شوند.را   Enterپس از وارد کردن داده ها کلید 

1 

2 
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 Closeکنید و جدول  خود را کامل نمایید و در نهایت روی گزینه  داده های سطر دوم به بعد را نیز به همین ترتیب وارد  

 کلیک کنید.

 

 شکستن متن در سلول ها  -15

اگر متنی را در یکی از سلول های اکسل نوشته اید و اکنون می خواهید هر بخش از آن را در سلول های مختلف بنویسید 

به تب    سلولی که متن را در آن نوشته اید انتخاب کرده و سپس  واقع می خواهید آن را بین چند سلول بشکنید کافی استدر  

Data   بروید و از قسمتData Tools   گزینهText to Columns .را انتخاب نمایید 
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 کلیک کنید. Nextرا انتخاب کنید و بر روی   Delimitedدر پنجره باز شده گزینه  

 
را انتخاب کنید. اگر جداکننده ای متن  نوع جدا کننده بین بخش های مختلف    ،Delimitersدر قسمت    در پنجره بعدی

نید و جداکننده  را بز  Otherقرار داده اید در بین گزینه ها وجود ندارد، می توانید تیک گزینه    متن  که شما بین بخش های مختلف

  Nextبه عنوان جداکننده تعریف شده است. سپس روی    Spaceمورد نظر خود را در کادر مقابل آن تعریف کنید در اینجا  

 کلیک کنید.

1 

2 
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 نید. را انتخاب ک Finishدر نهایت گزینه 

 

1 

2 
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16- Group  کردن 

شما در صورت نیاز می توانید چندین سطر یا چندین ستون را زیر مجموعه یک سطر یا یک ستون اصلی قرار دهید. برای  

 های زیر مجموعه یک سطر یا ستون اصلی را انتخاب کنید.  این کار کافی است سطرها یا ستون

 
 کلیک کنید. Group، بر روی Outlineز قسمت رفته و ا  Dataسپس به تب   

 
 )سرپرست خانواده( شده اند. 1زیرمجموعه ردیف ( خانواده)اعضای  4و  3، 2می بینید ردیف های همان طور که 

1 2 



 

76 
 

 
کردید را جمع کنید تا نشان داده نشوند و در زمانی که به آنها نیاز    Groupشما می توانید زیر مجموعه هایی که با هم  

 داشتید دوباره آنها را باز کنید.

 
کرده اید را از زیرمجموعه بودن خارج کنید باید آنها را    Groupکه بخواهید سطرها یا ستون هایی که قبلاً    در صورتی

 را انتخاب کنید.   Ungroupگزینه   Outlineبروید و از قسمت  Dataانتخاب کرده دوباره به تب  

 لیست آبشاری  -17

 برای تهیه لیست آبشاری در اکسل دو راه وجود دارد:
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ز گزینه هایی که می خواهید در لیست آبشاری نمایش داده باید هر کدام ا ابتدا  ،  Data Validationبا استفاده از    -1

یک سلول بنویسید سپس سلولی که می خواهید لیست آبشاری در آن قرار داشته باشد را انتخاب کنید و از تب    شوند را در 

Data   قسمتData Tools   گزینهData Validation  نمایید. را کلیک 

 
 کنید.را انتخاب  Listز کنید و گزینه  را با Allow، لیست آبشاری کادر  Settingsدر پنجره باز شده در تب 

 
این  محدوده ی سلول هایی که گزینه های لیست آبشاری در آنها نوشته شده است را انتخاب کنید.    Sourceدر قسمت 

 کنید.کلیک  OKسپس بر روی گزینه  محدوده به صورت خودکار فیکس می شود. 

1 2 
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4 
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بدون می بینید که لیست آبشاری در سلولی که انتخاب کرده بودید، ایجاد می شود. این نوع لیست آبشاری را می توان  

 ر نیز انتقال داد.به سلول های مجاو Drag & Dropبا  انجام مجدد مذاحل فوق و 

)مانند  ای فعال کردن آن  این قابلیت اکسل به صورت پیش فرض غیرفعال می باشد. بر،  Combo Boxبا استفاده از    -2

 مسیر زیر را دنبال کنید: ( 14قسمت 

File → Options → Customize Ribbon 

آبشاری   لیست  باز شده  پنجره  گزینه    Choose commands fromدر  و  باز کرده   Commands Not inرا 

Ribbon  .در کادر پایین از بین گزینه های موجود،    را انتخاب کنید Combo Box (Form Control) .را انتخاب کنید

مشاهده می کنید   را انتخاب کنید.  Addکنید تا تب جدیدی به وجود بیاید و در نهایت کلیک    New Tabسپس روی گزینه  

 کلیک کنید. OKدر تب جدید ظاهر می شود سپس روی گزینه   Combo Box (Form Control)که گزینه 

ابتدا باید هر کدام از گزینه هایی که می خواهید در لیست  Combo Boxبرای ایجاد یک لیست آبشاری با استفاده از 

)اگر گزینه های لیست آبشاری به صورت سطری   بنویسیدو حتماً به صورت ستونی آبشاری نمایش داده شوند را در یک سلول 

کلیک کنید. در هر    Combo Boxروی گزینه رفته و   New Tabرد( سپس به کار نخواهد ک Combo Boxنوشته شوند  

 و تا اندازه دلخواه آنرا بکشید و رها کنید. که می خواهید لیست آبشاری را ایجاد کنید کلیک کنیدجایی از صفحه اکسل 
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2 

1 
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 . را انتخاب کنید  Format Controlبر روی لیست آبشاری ایجاد شده راست کلیک کنید و گزینه 

 
باز شده در تب   انتخاب کنید.   Input range  بخش، در  Controlدر پنجره  محدوده گزینه های لیست آبشاری را 

می توانید تعریف کنید که    Drop down linesفیکس خواهد شد. در بخش    آدرس این محدوده به صورت خود به خود

، لیست آبشاری سه  را فعال کنید  D shading-3حداکثر تا چند گزینه در لیست آبشاری نمایش داده شود و اگر تیک گزینه  

 انتخاب کنید.را   OKواهد شد. در نهایت گزینه بعدی خ 

 
، در  Data Validationایجاد شود برخلاف لیست آبشاری حاصل از  Combo Boxلیست آبشاری که با اسفاده از  

  Data Validationقرار می گیرد. به طور کلی ایجاد لیست آبشاری با استفاده از    Shapeسلول ها قرار نمی گیرد بلکه در یک  

 سهل تر، پرکاربرد تر و بهتر است.

1 

2 
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 ( Pivot Table & Pivot Chartجدول و نمودار محوری ) -18

 جدول و نمودار محوریایجاد  18-1

داده های  خاص    که درباره یک موضوع   برده می شود برای تجزیه و تحلیل داده ها به کار    زمانی  جدول و نمودار محوری 

معمولی دشوار و سخت باشد. در چنین مواقعی  نمودارهای    جداول و  وجود داشته باشد و تجزیه و تحلیل آن از طریق   زیادی 

وجود  زیر اطلاعات متعددی درباره انواع لپ تاپ  در مثال  جدول و نمودار محوری تجزیه و تحلیل را بسیار آسان خواهد کرد.

 . شوددارد که نمی توان آنها را در جداول و نمودارهای معمولی تجزیه و تحلیل کرد پس از جدول و نمودار محوری استفاده می  

بر اساس آنها جدول و نمودار  باید محدوده اطلاعاتی که می خواهید  ابتدا  افزار اکسل  نرم  این امکان  از  استفاده   برای 

را باز کرده و گزینه    PivotChartلیست آبشاری    Charts، در قسمت  Insertتب    و در  رسم کنید را انتخاب کرده  محوری

PivotChart & PivotTable یید.را انتخاب نما 

 
کلیک کنید و   PivotChartاگر بخواهید فقط نمودار محوری را رسم کنید باید در همین لیست آبشاری روی گزینه   

کنید و مراحل زیر را  کلیک    PivotTableروی    Tablesدر قسمت  ل محوری را می خواهید در همین تب،  اگر فقط جدو

 انجام دهید.

 Selectگزینه در پنجره باز شده  را انتخاب کرده اید، یه و تحلیل چون شما محدوده داده های مورد نظر خود برای تجز

a table or range    انتخاب شده است و آدرس محدوده مورد نظر نیز در کادر مربوط به این گزینه به صورت فیکس شده

ایل ایجاد شود ول در همین فاگر می خواهید جدجدول محوری را مشخص کنید.  درج شده است. در قسمت بعد شما باید مکان  

مربوط به آن یک سلول دلخواه از صفحه اکسلی    Locationنمایید و در کادر  را انتخاب    Existing Worksheetگزینه  

 .بزنیدرا  OKدر نهایت  کنید تا جدول در آنجا ایجاد شود و که در آن هستید را انتخاب 

1 
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این جدول و نمودار باید از کادر   داده می شود. جهت انجام تنظیماتجدول و نمودار محوری به صورت خام نمایش  

PivotChart/Table Fields  .اگر به هر دلیلی این کادر بسته شد   که در سمت راست صفحه ظاهر می شود، استفاده کرد

از سربرگ   و  نمودار محوری کلیک کرده  یا  است روی جدول   PivotChart/Tableبرای دوباره ظاهر کردن آن کافی 

Tools   تبAnalyze   گزینه ورا انتخاب کردهField List  .را فعال کنید 

 
یعنی باید انجام دهید    PivotChart/Table Fieldsاز طریق کادر    تنظیمات جدول و نمودار محوری رااکنون باید  

این امر کاملاً به داده ها بستگی دارد و شما در موارد مختلف  مشخص کنید کدام داده ها در کدام قسمت جدول و نمودار بیاید.

دهید که   تشخیص  باید  باشد.خودتان  داشته  مفیدی  و  مناسب  نمودار شکل  تا  بگیرند  قرار  در کجا  ها  کادر    داده  در  معمولاً 

PivotChart/Table Fields داده های عددی در قسمت VALUES  های  قسمت و سایر داده ها به تناسب درAXIS   و
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LEGEND  روی  نشان داده شده در شکل    در کادر های مختلف کافی است  برای قرار دادن داده ها در قسمت    .قرار می گیرند

  داده ها در کادر   پس از انجام این کار،  رها کنید.مورد نظر خود کشیده سپس    ، نگه دارید و آنها را تا قسمتکلیک کنید  داده ها

 که به معنای قرار گرفتن در بخشی از جدول و نمودار است.نشان داده شده تیک می خورند 

 
 در مثال فوق بخشی از جدول و نمودار محوری به شکل زیر خواهد بود.
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 پس از رسم  بروزرسانی اطلاعات جدول و نمودار محوری 18-2

خود جدول و نمودار محوری را پس از رسم آنها تغییر دهید، جدول و نمودار محوری خودبه   اطلاعات در صورتی که  

 ای این کار دو روش وجود دارد:تغییر نخواهند کرد و باید اطلاعات آنها را بروزرسانی کنید. بر

 را انتخاب کنید. Refreshروی جدول یا نمودار محوری راست کلیک کرده و گزینه  -1

 

1 

2 
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 کلیک کنید. Refresh Allروی گزینه   Connections، از قسمت  Dataدر تب   -2

 

 جدول و نمودار محوری پس از رسم  تغییر محدوده اطلاعات  18-3

  Analyzeتب    PivotChart/Table Toolsروی جدول یا نمودار محوری کلیک کرده و از سربرگ    کاراین    برای

 را انتخاب نمایید.  Change Data Sourceگزینه  Dataرا انتخاب کنید. در قسمت 

 
باز شده، می توانید محدوده اطلاعاتی که مبنای رسم جدول و نمودار محوری است، را تغییر دهید و سپس  در پنجره  

 کنید.را انتخاب   OKگزینه  
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19- Solver 

این امکان به   Solverافزونه   یکی از امکانات اکسل است که در حل مدل های ریاضی مورد استفاده قرار می گیرد. 

 مسیر زیر را دنبال کنید:  Solver افزونه صورت پیش فرض در اکسل فعال نیست. برای فعال کردن

File → Options → Add-ins 

 Goقرار دارد، بر روی    Excel Add-insگزینه    اگر لیست آبشاری روی  Manageدر پنجره باز شده، در قسمت  

 کلیک کنید.

 
 در پنجره باز شده اعمال زیر را انجام دهید. 
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 ظاهر می شود. Analyzeو در قسمت   Dataدر تب   Solverمی بینید که 

 
 مدل ریاضی زیر را در نظر را در نظر بگیرید: 

3X+ 6 2X+ 3 2
1XMax Z = 2 

S.to: 

X1 + 2X3 ≤ 150 

3X2 + 5X3 ≤ 200 

X1 + X2 + X3 ≤ 500 

Xi ≥ 0 

در    Solverمتناسب با    را  مدل ریاضی  باید اینحل کنید. برای این کار    Solverفرض کنید می خواهید این مدل را با  

 مدل ریاضی در شکل زیر نشان داده شده است. این نوشتن  برای . ساختار کلیاکسل بنویسید

 
نوشته    Formula Bar  سلول های مشخص شده در شکل فوق و در   ی این مدل باید درفرمول تابع هدف و محدودیت ها

آدرس سلول های    )X 2, X 1X ,3(  متغیرهای  به جای  شود و از قوانین تابع نویسی پیروی می کند. در نوشتن این فرمول ها

 یعنی تابع هدف باید به صورت زیر نوشته شود: نوشته می شود ،در ساختار فوق )جواب آنها( مقابل آنها

 

1 

2 

3 

 تابع هدف  -1

 محدودیت ها  -2

 جواب متغیرها  -3
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 شوند: و محدودیت ها نیز به شکل زیر نوشته می 

 
 نوشته شده است و آماده ی حل است. در اکسل Solverمدل ریاضی متناسب با  اکنون این
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  انتخاب کنید.  (ه کردید)که خود آنرا اضاف Solverگزینه  Analyzeز قسمت رفته و ا  Dataحال برای حل آن به تب  

نوع تابع    Toسپس در قسمت    را انتخاب کنیدکرده و سلول تابع هدف  کلیک    Set Objectiveدر پنجره باز شده، در کادر  

  By Changing Variable Cellsهدف را انتخاب کنید که در این جا تابع هدف از نوع ماکزیمم سازی است. در کادر  

 کلیک کنید.  Addبرای اضافه کردن محدودیت ها نیز روی گزینه   کرده و محدوده جواب متغیرها را انتخاب کنید.کلیک 
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گزینه   روی  کلیک  کنید.  ایپنجره    Addبا  وارد  آن  در  را  محدودیت  باید  که  شود  می  قسمت    باز   Cellبرای 

Reference  انتخاب کرده و   وسط علامت محدودیت را از لیست آبشارینوع سلول فرمول محدودیت را انتخاب کنید سپس

را انتخاب کنید و در نهایت روی گزینه    (Right Hand Side)  محدودیت  سلول مقدار سمت راست  Constraintدر قسمت  

OK    دودیت وارد  کنید تا مح کلیکSolver    شود. اگر علامت محدودیت ها با هم متفاوت باشد باید محدودیت ها را تک

با هم وارد کنید فقط باید به این نکته مهم توجه  تک وارد کنید ولی اگر علامت محدودیت ها یکسان باشد می توانید همه آنها را  

فرمول محدودیت را از بالا به پایین انتخاب می کنید مقادیر سمت راست را هم از بالا به پایین انتخاب کنید داشته باشید که اگر 

ن مثال چون علامت شوند. در ای می  Solverچرا که اگر ترتیب انتخاب آنها متفاوت باشد، محدودیت ها به صورت غلط وارد 

 کی است هر سه محدودیت با هم وارد می کنیم.محدودیت ها ی

 
شده اند. گزینه    Solverنشان داده می شوند و وارد    Subject to the Constraintsمی بینید که محدودیت ها در کادر  

ativeNeg-Make Unconstrained Variables Non    0 ≤در واقع به معنای iX    می باشد پس باید برای این مدل تیک

آبشاری   لیست  در  بزنید.  را  کنید.    Select a Solving Methodآن  انتخاب  را  مدل  حل  روش  توانید   GRGمی 

Nonlinear  ل های خطی و هم غیرخطی مناسب است ولی  هم برای حل مدSimplex LP    فقط برای حل مدل های خطی

است. د از  مناسب  است پس  غیر خطی  نظر  مثال مدل مورد  این  انجام همه    GRG Nonlinearر  از  استفاده می شود. پس 

 کنید تا مدل حل شود.کلیک  Solveتنظیمات فوق نهایتاً بر روی 
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ببینید، را    Solverرا فعال کنید و اگر می خواهید گزارش کارهای    Keep Solver Solutionدر این پنجره گزینه  

 کنید.را انتخاب   OKرا بزنید سپس   Outline Reportsنوع گزارش مورد نظر خود را انتخاب کرده و تیک گزینه  

 

1 

2 

3 

4 

1 

2 

3 

4 



 

91 
 

 بالاخره و پس از طی تمام مراحل فوق مدل حل می شود. 

 


